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Outlook 2013 for Windows

Tasks

Outlook Tasks Folder

As with other Outlook main folders, the Tasks folder has multiple tabs with various commands which displays as a
ribbon; the commands are organized in logical groups. Below are screenshots of the command tabs for the Tasks folder.

To display the Tasks folder, click , the Tasks icon below the Folders in the Navigation, or press Ctrl+4.
Tasks Command Tabs and Ribbon

Tasks Home Command Tab: New, Delete, Respond, Manage Task, Follow Up Current View, Actions, Tags
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Folder Command Tab: New, Actions, Share and Properties
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View Command Tab: Current View, Arrangement, Layout, People Pane and Window
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Customize the Quick Access Toolbar New Tasks

As with the Quick Access Toolbars throughout Office 2013, each Outlook new item window has its own Quick Access
Toolbar that can be customized by the user. Steps to customize the Quick Access Toolbars throughout Outlook are
outlined in the Outlook 2013 for Windows QRG 1 - Getting Started.

The Task Views

When displaying the Tasks, the Home Tab and the View Tab include commands for several default views: Detailed,
Simple List, To-Do List, Prioritized, Active, Completed, Today, Next 7 Days, Overdue and Assigned views. In
addition, the To-Do Bar can be enabled and include Calendar, People and Tasks frames. To learn how to customize
views, see the Outlook 2013 for Windows QRG 4 - View Customizations.

I c D For software training, contact the Computer Training Center (CTC) at 358-1111 or visit the

—_——— : :
—_ CTC Web site at http://itcd.hqg.nasa.gov/ctc.
Information Technology &

Communications Division
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Detailed Task View
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Simple List Task View
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Calendar with Daily Task List

Another view that is beneficial is a combination of the Calendar
with the Daily Task List displayed below each day (shown right).
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With this view enabled, you will have a very good idea of the
meetings for the day along with projects to be started or due.

1.
2.
3.

4,

Click the Calendar icon below the Folder list in the Navigation.
Click View Tab | Daily Task List to display a drop-down menu.

From the drop-down list, click to display Normal, Minimized, or
Off.

Click Arrange by to select to display by Start Date, by Due
Date, and/or Show Completed Tasks.

The Daily Task List will then display at the bottom of each day in
the Calendar.

Bring Your Own Project!
HQ-CR-2H40
HQ-CAL-CTC

SoftPhone: HQ-CR-2HA0; HQ-CAL-CT —|

Windows 7; HQ-CR-2H40; HQ-CAL-C' I

2013 8 21 Excel 2011 for MAC .. [ I*
2014 8 25 Word 2011 for MAC .. Il |
2013 8 15 Pawerpoint 2011 for .. [l

2013 9 23 Excel 2010 for windo.. [l >
2013 11 25 Excel 2011 for mac .l >

Williams, Tiffany N. (HQ-LMO40)[MI

SoftPhone for Mac: HQ-CR-2)40; HQ —|

Word Play!; HQ-CR-2H40; HQ-CAL-C1

This document is posted on the ITCD Web site http://itcd.hq.nasa.gov/ctc.



Outlook 2013 for Windows QRG 8 - Tasks
To-Do Bar

1.

To enable/disable the To-Do Bar, click View Tab | To-Do Bar. Select to
display Calendar, People, Tasks or not display it by selecting Off.

Click the X in the upper right to hide the To-Do Bar. Click the horizontal divider
and drag up/down to adjust the display area for the Tasks, etc.

New Tasks

Create a New Task

1.

Click the Task icon below the Folder List in the Navigation to display the

Tasks folder.

When in the Tasks, click New Task on the Home Tab or use the shortcut
keystroke Ctrl+N to create a new task. When not displaying the Tasks, use
the keystroke Ctrl+Shift+K to create a new task. The New Task dialog box

displays (shown lower right

Enter a textual description for the task in the Subject
field.

Enter a Start date, Due date, Status, Priority and %
completed in the fields provided.

Enable the Reminder checkbox and set the reminder
date and time.

Use the features on the Task command tabs (discussed
in the section entitled Task Window Command Tabs at
page 4) to insert items, format text, mark private or
spellcheck.

Outlook tasks can be used to capture billable information for
accounting and timekeeping purposes.

7.

Click Details (shown right) to display the additional fields
Date completed, Total work, Mileage, Actual work,
Billing information and Company.

Click Save & Close.

Assign a Task

1.
2.

6.

Follow steps 1-5 above.

Click Assign Task to delegate the task to another person.
A To field displays along with two checkboxes with owner
monitoring options.

Click the To button to search for and select the task
assignee.

Click the checkbox to enable/disable Keep an updated
copy of this task on my task list.

Click the checkbox to enable/disable Send me a status
report when this task is complete.

Click Save & Close.

To view tasks you have assigned to others, from the Task folder,
click Home Tab | Assigned view.
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Outlook 2013 for Windows QRG 8 - Tasks
Respond to Task Request
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Task Requests are very similar to Meeting Requests, in that they arrive as an e-mail message and should be

responded to via the Task Request window.

H- "

1. Openthe Task Request message (shown right).
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2.

Respond via the buttons to Accept, Decline,
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Reply, Reply all, or Forward as appropriate. 0
3. Use the features on the Task command tabs
(discussed in the section entitled Task Window
Command Tabs at page 4) to assign the task,
categorize, flag for follow up, or mark private.

4.  Click Assign Task to delegate the task to
someone else. 5

Click Send Status Report to forward send a status report to the delegator of the task.
Click Save & Close.

Task Window Command Tabs

Task Command Tab: Actions, Show, Manage Task, Recurrence, Tags and Zoom
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e C(lick Forward to attach the task to an e-mail message.

e C(lick Mark Complete to change the task from active to completed.

e Click Assign Task to delegate the task to another party. You can monitor the task through the Assigned view.
e C(lick Send Status Report to update the owner of a task assigned to you.

e Click Recurrence to create a recurring pattern for the task. See the section entitled Create a Recurring Task at
page 5 for more information.

e Click Follow Up to flag the task.

e  C(lick Private to mark the task private and therefore prohibit even delegates with access to your task from
reading the full detail.

e (Click High Importance or Low importance to tag the task appropriately.

Insert Command Tab: Include, Tables, Illustrations, Links, Text and Symbols
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e  (lick Attach File to insert a document into the task.
e  C(lick Outlook Item to insert any Outlook item (Message, Note, etc.) into the task.

e C(lick Business Card to insert a business card for a contact stored in your Contact list.

e  C(lick Signature to display a drop-down list of your stored signatures. Click to select the one to insert.
Instructions to create an Outlook Signature are outlined in the Outlook 2013 for Windows QRG 3 - Mail.

e (lick Table to insert a table with Word 2013 Table functionality. The Table Tools Design and Layout
Command Tabs display.

e  C(lick any of the Illustrations, Links, Text or Symbol commands to insert the appropriate item.

This document is posted on the ITCD Web site http://itcd.hq.nasa.gov/ctc.
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Format Text Command Tab: Clipboard, Font, Paragraph, Style and Editing
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e Select text to be edited and then click any of the buttons to apply changes:

o Cut, Copy, Font, Paragraph or Styles.
o Click Paste to insert cut or copied text.

e  Select the text with the desired formatting then click Format Painter to copy the format one time from the
selected text and paint the same format over newly selected text. Click the Format Painter twice to turn on the
feature and paint formatting over selected text multiple times. Click Format Painter once to turn it off.

e  (Click the Clipboard, Font, Paragraph or Style dialog box launchers to display the full dialog boxes for each set

of commands.

Review Command Tab: Proofing and Language
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e  (lick Spelling & Grammar to check the spelling or grammar of the Task.

e Click Research to display the Research Task Pane with fields to search reference materials and online.

e  Select text and click Thesaurus to find a synonym of the selected word.

Create a Recurring Task

1. Inthe Task window, click Task Tab | Recurrence. The
Task Recurrence dialog box displays (shown right).

2.  Establish the recurring pattern by select either Daily,
Weekly, Monthly or Yearly.

3.  Enter the number of recurrences in the Recur every [ ]
weeks / months / or years field (field changes based on
recurring pattern selection).

4. Select the days of the week on which the task should be
completed.

5. Inthe Range of Recurrence section, select the Start
Date.

6.  Select the range of recurrences to End after [ ]
occurrences or to End by a specified date.

Task Recurrence L&J
Recurrence pattern
Daily @ Recur every |1 week(s) on
Q) weekly Sunday Monday Tuesday /| Wednesday
Manthly Thursday Friday Saturday
Yearly Regenerate new task 1 week(s) after each task is completed
Range of recurrence
Start: |Wed 4/16/2014 E Mo end date
Q@ End after: |10 occurrences
End by: wed 6/18/2014 E
Cancel Remove Recurrence

Never select No end date as the recurrence will continue forward in time without end. Rather, end recurring items at
the end of the current year and create a new recurring item for the next year. Recurring tasks that carry over through
several years can become corrupt over time and causes performance issues in Outlook.

Also, do not include attachments in recurring items. Attachments will be included in every instance of the recurring item
which will use valuable server space toward your Outlook mailbox maximum quota size.

7.  Click OK when complete.

This document is posted on the ITCD Web site http://itcd.hq.nasa.gov/ctc.
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Task Options

Click File Tab | Options | Tasks to display the Task options and change how you work with your tasks.
Task Options

Click the checkbox to enable/disable the option Set reminders on tasks with due dates.

Click the drop-down arrow for Default reminder time and select the time to be reminded on tasks with due
dates.

Click the checkbox to enable/disable the option Keep my task list updated with copies of tasks I assign to
other people.

Click the checkbox to enable/disable the option to automatically Send status report when I complete an
assigned task.

Click the drop-down arrow for Overdue task color and select from the options provided.
Click the drop-down arrow for Completed task color and select from the options provided.

Click Quick Click to set the default behavior when single-clicking on the Flags column in the Mail folder. The Set
Quick Click dialog box displays. Click the drop-down arrow and select the single-click Flag default.

Tasks Options: Work Hours

Click the drop-down arrow for the Task working hours per day to select the number of hours you work each
day.

Click the drop-down arrow for the Task working hours per week to select the number of hours you work each
week.

Task Shortcut Keystrokes

To do this Press To do this Press
Show or hide the To-Do Bar. ALT+F2 Select all items. CTRL+A
lAccept a task request. ALT+C Delete selected item. CTRL+D
Decline a task request. ALT+D Forward a task as an attachment. CTRL+F
Find a task or other item. CTRL+E Create a task request. CTRL+SHIFT+ALT+U
Open the Go to Folder dialog box. CTRL+Y Switch between the Navigation Pane, TAB or SHIFT+TAB
Tasks list, and To-Do Bar.
Create a task (when in Tasks). CTRL+N Open selected item as a Journal item. CTRL+]
Create a task (from any Outlook view). CTRL+SHIFT+K  Undo last action. CTRL+Z
Open selected item. CTRL+O Flag an item or mark complete. INSERT
Print selected item. CTRL+P
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